Getting started with Mendeley

Guide by ITC library

January 2015
# Table of Contents

1. Mendeley in not even 10 steps .................................................................................................................. 3
   1.1 Go to www.Mendeley.com and register ................................................................................................. 3
   1.2 Download Mendeley desktop .................................................................................................................. 3
   1.3 Find your browsers bookmark toolbar .................................................................................................... 4
   1.4 Install the Word plugin ............................................................................................................................ 5
   1.5 Start building your library ......................................................................................................................... 5
   1.6 Create your Watched Folder : ................................................................................................................. 7
   1.7 Inserting citations and references – two ways ......................................................................................... 8
   1.8 Change your citation and output style ..................................................................................................... 9
   1.9 Edit your citation ....................................................................................................................................... 10

2. Mendeley things to know .............................................................................................................................. 11
   2.1 Research databases ................................................................................................................................. 11
   2.2 Importing references / drag and drop pdf ............................................................................................... 11
   2.3 The DOI saves the day ............................................................................................................................. 11
   2.4 Literature Search in Mendeley Crowd-sourced online research catalogue ........................................ 12

3. Organizing your Mendeley library ................................................................................................................ 13
   3.1 Import other libraries ............................................................................................................................. 13
   3.2 Create folders & sub-folders ...................................................................................................................... 14
   3.3 Search the full-text of your library .......................................................................................................... 14
   3.4 Where are my pdf’s? ................................................................................................................................. 15
   3.5 Read, mark and add sticky notes to the saved articles ........................................................................... 15
   3.6 Automatically organizing your pdf’s ........................................................................................................ 16

4. Document-types and output-styles ................................................................................................................ 17
   4.1 Different document types ......................................................................................................................... 17
   4.2 Output styles ........................................................................................................................................... 18

5. Mendeley and BibTex / LaTeX ....................................................................................................................... 19
   5.1 Export from Mendeley to BibTex ............................................................................................................ 19
   5.2 Automatically create a BibTex files .......................................................................................................... 19

6. Mendeley online ............................................................................................................................................ 20
   6.1 Create a group ......................................................................................................................................... 21
   6.3 Create your own profile ............................................................................................................................ 22
1  Mendeley in not even 10 steps

Mendeley is a free reference manager that helps you keep references and literature for your research organized. You can:

- Create and manage citations of books, articles, and more
- Import citations from online resources and publisher’s websites
- Automatically extract metadata from imported PDFs
- Collaborate with other researchers online
- Highlight and annotate papers and share those notes with others

Because you have a desktop version and an online version that synchronize you can always work anywhere, from any device and have your library up to date. 2GB of online storage is available.

1.1  Go to www.Mendeley.com and register

Two important things:
1. Create your account using your personal mail adres: name@yahoo.com, name@gmail.com
2. Install Mendeley desktop in your documents folder, this way it is easier to back-up your references and more important your pdf’s.

1.2  Download Mendeley desktop


From the my library tab on the online library go to the button ‘web importer’ to drag the ‘save to Mendeley’ button to the bookmarks toolbar of your browser(s). You can also do this later from the Tools menu in Mendeley desktop.
1.3 Find your browser's bookmark toolbar

Firefox: right-mouse-click the top bar of your browser, and tick the box for 'bookmarks toolbar'.

Chrome: click the menu icon (see red box) move your mouse to 'bookmarks' and 'show bookmarks toolbar' activate this.

Internet Explorer: right-mouse-click the top of your browser, and tick the box for 'Favorites bar'.
1.4 Install the Word plugin

Go to the tools menu in the desktop version. Also you can select another plugin for other word processors.

1.5 Start building your library

Importing references with the help of the save to Mendeley button from for example Elsevier, Web of Science, ACM or Wiley online library. The first time in any session you want to import a reference you will be asked to sign in with your Mendeley account. Some examples and notes below:

From Science Direct by Elsevier.

If you have a search with 6 results, and click “save to Mendeley”, the export of all references on your screen will start. You can then select the ones you really want from the download list on your screen. Do NOT do this with a result of 12,354 articles! refine your search, or go to one of the articles on your screen and save that one.
From Web of Science:
To use ‘save to Mendeley’ in Web Of Science, you need to be registered with WOS and be signed in.

From ACM digital library
The Mendeley web importer will start and offer you the option to include the pdf, and to select the library folder in which you want to ‘add’ this reference.

View in Mendeley Desktop by using the “view in Mendeley desktop” button, do not skip this!
You have not switched from the bibliographic database for literature to Mendeley desktop.

Mendeley now shows you the record, highlighted so you can check and edit the record, and add the pdf by clicking the blue download sign (pdf is not always added directly) if the pdf does not load, save it manually in your Mendeley pdf (watched) folder.

You may have noticed : the pdf is not always automatically imported with the reference.

Now is the time to:

1.6 Create your Watched Folder

In your own folders create a new folder you want to be the dedicated pdf folder for automatic reference import. Next from your desktop library, go to: file, watch folder, navigate to the just created folder to tell Mendeley your preference.

Save a pdf in this specific folder that you have designated your watched folder and your references will be added automatically to your library.

Please check this, because the pdf needs to contain enough metadata to form a reference.

This is how you add a pdf to an already imported reference. In ScienceDirect by Elsevier this also works for the ‘download multiple pdf’ option.
1.7 Inserting citations and references – two ways

Go to the reference tab in Word, click import citation and use the search bar to find the reference you want to insert in your work, type author or a distinguishing title word.

from word, references tab, click insert citation, then on the search bar click Go To Mendeley to select your reference,

Then you will get the “send citation to plugin” button, meaning send citation to Word button. This way you can also combine two references in one citation.

Mendeley will only add the citation, without reference to your word document. You can add all citations for your paper before adding the references / bibliography with one click of a button. Or if you choose, ‘insert citation’ first, then ‘insert bibliography’ and from now on Mendeley will add citation and reference simultaneously.
1.8 Change your citation and output style by using the drop down menu in Word

Or the View menu in Mendeley desktop
1.9 **Edit your citation**

To place the author outside the brackets. Simply click the citation. Immediately upon doing this your ‘insert citation’ button now says ‘edit citation’. Then just manually edit the text of your citation in Word. Mostly just move the first bracket. When you are done, put your cursor elsewhere in the text and you will be asked if you want to keep this manual edit.

![Image of Mendeley Cite-O-Matic](image)

(Benton & Newell, 2014)

Later it’s possible to undo this simply by clicking on the citation and use the “undo edit” button. This Mendeley insert citation button has a multi-purpose function!

![Image of Mendeley Cite-O-Matic](image)

(Braimakis, Atsonios, Panopoulos, Karellas, & Kakaras, 2014)

To completely exclude the author; click the citation, click the now so called ‘edit citation button’ put your cursor on the author’s name in the search bar and click the button “suppress author” this leaves only the Year. The Prefix and Suffix option add text before the author and after the year.
2 Mendeley things to know

All online resources and help by Mendeley http://resources.Mendeley.com/

2.1 Research databases

If you use research databases like Scopus, Web Of Science, Geobase or CAB for your research, where the Universities Journal subscriptions are integrated with the database, you may have to click a few times to get to the publishers site before you can download the full text pdf with the necessary metadata. Or type http://dx.doi.org/ in a new browser tab; add the doi http://dx.doi.org/10.1016/j.isprsjprs.2010.06.005 and you will go straight to the publisher’s website Importing data with the SFX banner at the top of your screen, usually does not work. Importing the references from the original publisher’s website gives the best metadata.

2.2 Importing references / drag and drop pdf

If your “save to Mendeley” button does not work, for importing your records metadata try downloading the pdf to your Watched Folder. See instructions below.

Also due to SFX and or proxy servers the drag and drop option for pdf’s usually does not bring enough metadata to automatically create a reference. We recommend the Watched Folder as an alternative.

2.3 The DOI saves the day

If you have trouble exporting your references, try to find the DOI (Digital Object Identifier) of your article, put it in a New Reference (File, Add entry manually) and the Lookup function will complete your reference!
2.4 Literature Search in Mendeley Crowd-sourced online research catalogue

You can use the literature search – bar in Mendeley.

Which database are you using with this search option?

You’re searching Mendeley’s crowd-sourced research catalog with millions of papers.

Please be aware, this is not the search within your own library!

- It accepts Boolean operators, AND, OR and Not
- Truncation is possible: mode*ing for modelling or modeling
- Just tick the dot before one of the found references to save it to your library

Be aware that most publication types are not properly recognized, given as “generic” in the database. Use the look-up function with each reference to complete the reference.
3 Organizing your Mendeley library

3.1 Import other libraries.

Endnote or other libraries can be imported To Import from other bibliographic databases take these steps:

Example from Endnote

1. Select all references
2. Go to: File, and Export
3. Select location : Save in
4. Choose : File name
5. Save as type: XML
6. Output style: Endnote Export OR RIS
7. Tick the box : Export selected references
8. “Save”

Go to Mendeley

1. Go to: File, import, Endnote OR RIS
2. Navigate to the file you have just saved
3. .. and import
4. Mendeley will check for duplicates.
3.2 Create folders & sub-folders

Right click anywhere in the left hand pane to create folders and sub-folders. You can drag and drop files into folders from anywhere. We recommend starting with search to help find things fast. The real usefulness of folders is for reducing the scope of your search.

3.3 Search the full-text of your library

Search for a keyword in the top right to find documents instantly as you type. The search includes global notes and tags by default and you can filter specifically by clicking the filter arrow.
3.4 Where are my pdf’s?

A right mouse click on a saved pdf, from your desktop library will tell you where Mendeley has saved it.

See 3.6 for file organization

3.5 Read, mark and add sticky notes to the saved articles

If you double click one of the references in your Mendeley desktop the pdf will open, you can read, make notes, use the highlighter. Etc.

You can share this paper with annotations with your, supervisor or professor
3.6 Automatically organizing your pdf’s

From the Tools menu, select options and the File organizer tab. You can ask Mendeley to sort, rename and store your pdf in specific folders! simply drag the field name tags to where you want them.
First tick the “organize my files” option, then choose
- Sort files
- Rename documents
4 Document-types and output-styles

4.1 Different document types
Most used is the journal article, and if your paper and reference comes from one of the larger databases like Springer, Elsevier or Web of Science your reference and citation will be complete. Document types such as reports, msc and phd theses and especially websites may take some attention. In general, always check the reference you have just imported to see if all information is there.

When using the ‘save to Mendeley’ button on a website you have been using in your research the author of the website does not appear. As author of a webpage you usually use the Organization or institution that hosts the webpage. In case of a blog you name the person writing the blog.

If you use the reference of a website without an author, Mendeley will use the title of the website in your citation.

If you add a (corporate) author, you citation will change accordingly:

If you manually add the name of the institute, department, organization as author of the webpage, your citation will be clearer and the reference will make more sense. While typing the name of the author you will be offered the option of marking it as an institution/organization.

If the name of the organization has more than one part add a comma [ , ] at the end, this will keep the name in the same order and Mendeley will not try to change it into a family name with initials. For example “The World Bank” will not change into “Bank, T.W.” if you add the [ , ] at the end.

MSc or PhD theses
To clearly recognize a MSc or a PhD theses you may want to add (MSc thesis) or (PhD thesis) just after the title in your Mendeley record. You can use both ‘Book’ and ‘Report’ as record type for these publications in Mendeley.
4.2 Output styles

The APA style is one of the most used output and writing styles, the reference list generated following this style is very elegant and complete.

Please see this schedule on how many authors are used in citations of papers with more than one author.

Citation schedule for APA:

If you prefer to have only one author with each citation, select for example Harvard : imperial college London as an output style.

(Ramoelo et al., 2013)


Others prefer a style called Numbered where each citation is just symbolized by [3] for example instead of the author’s name. Also the well-known journal “Nature” uses a numbered style for its publications

Have a good look at both citations and references before you change your output style.
5. Mendeley and BibTex / LaTeX

5.1 Export from Mendeley to BibTex

http://libguides.mit.edu/content.php?pid=241351&sid=1992274

“How do I export from bto BibTeX?" 

Open Mendeley, and within "My Library" found on the left, select references that you would like to export to BibTeX. In the drop-down menu in the toolbar at the top of the screen, click "File --> Export" (or ctrl-E if you use keyboard shortcuts) and in the dropdown list of file types, chose "Save as type: BibTeX" and save to the same location as the LaTeX file.

If you’re working with Mendeley on a PC and your manuscript is on Athena, you’ll need to save the BibTeX export to your hard drive and use FTP or another file transfer method to transfer the file to the correct directory in your Athena space.

To link the bibliography file that you just downloaded to your document, you need to enter two commands: \bibliography{style} should go just inside your \begin{document} command. \texttt{style.bst} is the name of the style file dictating the format of your bibliography (see How do I change the format of the bibliography? below).

\bibliography{filename} should go wherever you want LaTeX to generate the bibliography. \texttt{filename}.bib is the name of the file that you just downloaded from RefWorks containing your exported references. “ (Green, n.d.)

5.2 Automatically create a BibTex files

Also from the Tools menu, and options, BibTeX tab you can set Mendeley to automatically create a BibTeX file for each reference in the library.
6. Mendeley online

Your online Mendeley library serves as backup and can act as your work platform when you do not have your ‘desktop computer’ at hand.

You can save references, maybe not always with pdf but the synchronization option of Mendeley will import them into your desktop version when you start-up the next time.

Your online storage capacity with Mendeley is 2GB

Some editing options are also available in the online version
6.1 Create a group

In the free version of Mendeley you can make only one private group of 3 people to share references and your work. You can however make more open groups to share references. In these open groups you can share references when working on a joint project. But you cannot share documents because of copyright.

6.2 Participate in groups

Already a lot of people with Mendeley account have joint groups of their interest, it’s possible to search available groups for your topic and see if useful discussions are going round.

You can ask to join if it is a closed group, or opt to follow their work.

The option to browse groups offers a nice start to see what’s available.
6.3 Create your own profile

To work with others, share your experience or build your own profile you can create a Mendeley profile on your online account page, click your name as mentioned after login. Now you can edit your profile, change who you want to follow etc.

Adding your papers will be offer to you by Mendeley, and of course you can add papers yourself.
By using the DOI in your url colleagues from all over the world with access to e-journals can find the papers you’re listing on your profile. To share these papers the use of author’s copies and pre-publication versions is usually allowed by publishers. Open Access papers know no restrictions in this sense.

REFERENCES